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Comparing a Transcript to Database Samples

A. Start SALT with Carter’s Transcript

=i

§) 1. The SALT program begins with the Getting Started window. In this exercise you will be starting with one
of the sample transcripts. Click the Open button and you are presented with the Open dialogue box.

2. Unless you changed the default transcript folder, the My SALT Data\Transcripts folder located within
your Documents folder is displayed. Open the Samples folder and then the Lesson Samples folder.

3. Select the transcript file Carter PGHW.slt from the “Lesson Samples” folder and then click the Open
button (or double click “Carter PGHW.slt”).

The transcript “Carter PGHW. slt” should be displayed. At the bottom right-hand side of the window, the
analysis set should be “C&I Verbal Utts” and the transcript cut should be “Entire Transcript”. If this is not the
case, use the Setup menu to make appropriate changes. Carter is retelling the story Pookins Gets Her Way
by Helen Lester (1987).

B. Compare transcript to samples from the Narrative Story Retell database

1. Select the Database Comparison Set.

e Before SALT can generate any of the database reports, you must select the database samples to use
for the comparison. Select Database menu = Select Database Samples and Settings. You are
presented with the “Select Database Samples” dialogue box. Notice there are 3 steps.

e STEP 1: Select Database

Carter’s language sample was elicited and transcribed following the protocol for the Narrative Story
Retell database retelling the story Pookins Gets Her Way (PGHW). The Narrative Story Retell
database and the PGHW subgroup should be pre-selected based on the plus lines (+Context: NAR
and +Subgroup: PGHW) at the top of Carter’s transcript.

— Click the Select Built-In Database button to view the list of available databases from which you
could compare your sample. Always make sure that the selected reference database is
appropriate for your sample. If the Narrative Story Retell database was not preselected, select it
from the list and click Open. Otherwise, select Cancel or click X in the upper right-hand corner.

- Click the Database Snapshot button for a description of the Narrative Story Retell database
followed by a summary of the database records. Scroll to the bottom and notice that there are
101 samples in this database retelling PGHW, ranging in age from 7;0 to 8;11.

- Press OK to close the database snapshot dialogue box.

e STEP 2: Select age, grade, and/or gender criteria

Use this section to select the subset of database samples that match Carter’s age, grade, and/or
gender. Notice the transcript information at the bottom of the dialogue box:
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Carter PGHW (Child), NAR (PGHW): CA = 8;1, Grade 2, Male, 311 NTW, 40 C&I Verbal Utts, Time: 5:32

The transcript filename is “Carter PGHW”. The target speaker label, taken from the $ speaker line at
the beginning of the transcript, is “Child”. This is a narrative sample based on the story Pookins Gets
Her Way (PGHW). Carter is male, aged 8 years and 1 month. The sample lasted 5-minutes and 32
seconds and contains 311 NTW (number total words) and 40 C&I Verbal Utts (complete and
intelligible verbal utterances). Carter’s age, gender, and sampling context came from the plus lines
at the beginning of the transcript.

- Look at the criteria selections. For questions about any of the criteria selections, click the Help
button in this dialogue box for details.

- The Age match is set at plus or minus 6 months. Since Carter’s age is 8;1, the database
participants must be in the age range of 7;7 to 8;7 to be included. The grade and gender
matches are not selected.

- Click the Find Matched Samples button to find out the number of database samples that match
the criteria you selected. Notice that there are 82 samples that are within 6 months of Carter’s
age.

e STEP 3: Select method used to equate samples by length

Some language measures, such as number of different words (NDW) and number of errors, may
vary significantly depending on the length of the sample. The longer the sample, the more
opportunity for using different words and for making errors. For measures affected by the length of
the sample, it is important to equate the database samples by length.

- Same number of total words is pre-selected as the default method of matching samples by
length. Notice at the bottom of the dialogue box that Carter’s sample contains 311 NTW. Using
this default selection, there are two ways to equate Carter’s sample with the matching database
samples.

1) Cut the matching database samples at 311 NTW to match the length of Carter’s sample.
Shorter database samples which do not contain at least 311 NTW would not be included.

2) Cut both Carter’s sample and the matching database samples to a fewer number of total
words, e.g., 250 NTW. This option would be used if too many of the database samples would
be excluded using the first method.

. Select Best Comparison Set pd
- Select Same number of total words and click P

. . Select the best combinati Show all
Find Equated Samples. You are presented with of samples and words. .

a dialogue box containing six options. The first Concel
option, “40 samples — 311 words” indicates e e e
66 samples - 234 words Help

that 40 of the 82 age-matched samples contain
at least 311 NTW. The last option, “82 samples

74 samples - 204 words
82 samples - 139 words

— 139 words” indicates that, in order to include
all 82 samples, all the samples would be cut at 139 words.
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You need to decide whether it would be better to have more database samples included in the
comparison set or more words included in the analyses.

As a rule of thumb, you should have at least 20 samples in the comparison set.

- Click OK to select the first option, “40 samples - 311 words”. The 40 database samples will be
cut at the point of 311 NTW. If the 311" word occurs in the middle of an utterance, all word-
based measures are calculated to the point of the 311" word. All utterance-based measures are
calculated up to the end of the utterance containing the 311* word.

- Click OK to close the dialogue box. The Database menu is displayed, and the database reports
are now available.

2. View the Standard Measures Report.
e Select Database menu > Standard Measures Report.

e You are presented with a dialogue box to select a length option to use for the comparison.

— Entire transcript: generate this report, comparing Carter’s entire sample with the entire sample
of all 82 age-matched samples.
= Advantage: uses all 82 age-matched samples.
= Disadvantage: the samples will not all contain the same number of words and several of the
measures may be significantly affected by the length of the sample.

- Equated by length: generate this report, comparing Carter’s entire sample (consisting of 311
words) with the first 311 words in the 40 samples containing at least 311 total words.
= Advantage: all measures are calculated on the same number of total words which levels the
playing field.
= Disadvantage: comparison outcomes are based on only 40 of the 82 age-matched samples.

- Measure-driven: combination of All and Equated : generate this report for a combination of
entire transcript or equated by length, depending on the type of language measure. Language
measures which are percentages or averages are based on the entire transcript (All: entire
transcript). Measures which count occurrences are italicized and based on samples equated by
length (Equated: by length).
= Advantage: Helps user to get the fairest comparison for each measure.
= Disadvantage: The option is only available if the report contains both types of language

measures — All and Equated.

Notice “Measure-driven is “recommended”. This is because the report consists of some measures
which are percentages or averages (typically based on the entire transcript), and some measures
that count occurrences (typically based on samples equated by length).
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Select Measure-driven and click OK.

After the selected database samples are analyzed, you are presented with the Standard Measures
Report (SMR).

Information about the transcript is displayed in the upper left-hand corner of the report. The
database information is displayed in the upper right-hand corner of the report. The Database menu
= Standard Measures Report contains the same measures as the Analyze menu =2 Standard
Measures Report. The difference is, in this report, Carter's sample is compared to the 82 age-
matched samples, and for some measures, 40 samples equated by the same number of total words
selected from the reference database.

There are several things to notice about the format and organization of this report:

The target speaker’s (Carter’s) score and standard deviation are listed first, followed by the
database statistics for the selected database participants.

Some of Carter’s scores are highlighted and followed by either one or two asterisks. These
values represent strengths or weaknesses. A single asterisk flags those values which are
between one and two standard deviations* from the database mean. Double asterisks flag
those values which are two or more standard deviations from the database mean.

The following measures are italicized: Number Total Words (NTW) and Number Different Words
(NDW). They are italicized as a warning that these measures count occurrences and can be
significantly affected by the different sample lengths.

*The default setting for the standard deviation interval is 1SD. The standard deviation interval setting can
be changed in the “Select Database Samples and Settings” dialogue box. If, for example, you set the
interval to 1.5 SD, the database analyses reports will highlight values 1.5 or more SD from the database
mean.

Look through the report.

TRANSCRIPT LENGTH. Carter used marginally more utterances, words, and time to retell the
story than his age-matched peers.

INTELLIGIBILITY. Carter’s sample was slightly less intelligible. Note that unintelligible segments
may reflect the quality of the recording.

SYNTAX/MORPHOLOGY. Carter’s mean length of utterance (MLU) in words and morphemes was
slightly lower than the comparison group’s. Verb use, a gross measure of sentence complexity,
was similar to his peers. All of Carter’s utterances included at least one verb. The mean verbs
per utterance value is just slightly lower than Carter’s database peers. You may consider
applying the Subordination Index (Sl) coding to this transcript (refer to the step-by-step exercise
on subordination index for details). It takes just a few minutes and provides a more accurate
measure of sentence complexity via clausal density.

SEMANTICS. The NTW value (311) is the number of total words in Carter’s sample. That value
was used to equate Carter’s sample to the database samples by length. Carter’s transcript
contained more NDW than the database transcripts, indicating that he used a wider range of
vocabulary to retell the same story. “Moving-average NDW” is computed by averaging the NDW
for each set of 100 words (Moving-Average NTW) starting with the first 100 words, then looking
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at words 2-101, then 3-102, and so on until it looks at the last 100 words. Note that the
“Moving-Average NDW” score is highlighted as being more than 1 standard deviation higher
than the database value, confirming that Carter uses a wider range of vocabulary than his peers.

Compare the NTW value of 311 in the SEMANTICS section with the “All Words Including
Mazes” value of 479 in the TRANSCRIPT LENGTH section. Why the large difference? “All Words
Including Mazes” counts all the words in the transcript while NTW counts those words in the
main body (excludes mazes) of the current analysis set (complete, intelligible, verbal - C&/
Verbal Utts). Carter’s sample included a significant number of words in mazes and 6 of his 46
utterances were not in the current analysis set.

— VERBAL FACILITY. Carter paused slightly more than his database peers and had significantly
more words in mazes (filled pauses, repetitions, revisions). The high number of mazes is an
indication that Carter may have word finding and/or utterance formulation difficulties.

e ERRORS. Carter’s transcript contained a slightly higher percentage of utterances with errors than the
selected comparison transcripts.

For questions on any of the language measures in this report, refer to the built-in help screen (|ﬁ|
or F1).

3. Save the Standard Measures Report as a PDF file.
e Windows® 0OS

Click the save icon M or select File menu > Save.

You are prompted to select the format of the file. Select PDF — Portable Document Format.
Make sure the box labeled Display report after saving is checked.

Click OK to close the dialogue box.

O O O O O

Select the location where you would like the report saved. By default, this is in the My SALT
Data/Reports folder. The default report filename is made up of the sample name plus _DBSMR
(database standard measures report). You can change both the location of the report and the
report filename.

o Save and view the report.
e MacOS

o Select File menu = Print. The PDF option is included in the Mac print dialogue box.

4. View the Performance Report.
e Select Database menu = Performance Report.

The Performance Report data is generated from the various reports within the Database and Analyze
menus used to create a cohesive narrative about the speaker’s expressive language performance,
noting both strengths and challenges. This is the only database report which can be edited in the
report window. The report can also be saved in RTF format which can be opened using Microsoft®
Word, or copied and pasted into electronic record-keeping programs.

e You are prompted with the “Performance Report Settings” dialogue box. The speaker is referred to
throughout the report by first name. The speaker’s first name, Carter, is taken from the “+ Name”
entry near the beginning of the transcript. Had it been missing, you would have the opportunity to
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enter the speaker’s first name. Similarly, the speaker’s gender, Male, is taken from the “+Gender”
entry in the transcript. The report contains many instances of “he/she/they”, “him/her/them”, and
“his/her/their”, based on the selection made in the gender options.

o Check the box labeled “Include goal bank”. This option is only available for the Database
Performance Report (not found using Analyze menu), and it is not available for linked samples.
When selected, a customized set of goals is displayed at or near the end of the Performance Report.
Suggested goals are derived from the language sample outcomes. It is important to use clinical
judgement when reviewing and choosing generated goals.

Note: Goals from the goal bank can also be generated independent of the Performance Report by
going to the Database menu, Goal Bank.

o Check the box labeled “Include list of relevant reports”. When this option is selected, a list of the
specific Database and Analyze reports used to generate the Performance Report is included at the
end of the Performance Report.

e C(Click OK to exit the dialogue box. The Performance Report is displayed.

e Read through the report. The first paragraph describes the elicitation task. It also indicates the
measures compared with the entire transcript of the 82 age-matched samples. A few measures,
such as total pause time and number of errors, may be affected by sample length. These measures
are compared with the 40 samples matched in length (the same number of words). The subsequent
paragraphs describe outcomes following the format of the Standard Measures Report. Suggested
goals from the goal bank are then listed. The end of the document lists the analyses reports used to
generate Performance Report.

e You can edit to this report to suit your needs, perhaps adding your clinical impressions.

o Note that the text in this report can be copied and pasted into a word processor or directly into your
evaluation.

e For questions about this report, refer to the built-in help screen (|£I or F1).

e If you want to print this or any other report, click the print icon |§I or select File menu - Print....

5. Save the Performance Report as an RTF file and open it in Microsoft® Word.

e C(Click the save icon M or select File menu > Save.



Step-by-step Exercise Comparing a Transcript to Database Samples 7

You are prompted to select the format of the file. Select RTF — Rich Text Format (Word). Make sure
the box labeled Display report after saving is checked.

Note that the Performance Report is the only database report which can be edited or saved
as an RTF file.

Click OK to close the dialogue box and save the report.

You are prompted to save the report on your computer. The default location to save SALT reports is
in the folder My SALT Data/Reports within your Documents folder. Keep this default or select a
different location. The filename for this report is Carter PGHW_DBPR.RTF where DBPR stands for
“Database Performance Report”. Click Save to save the report.

Your report is opened in Microsoft® Word or whatever program is associated with RTF files. Close
this window and go back to the SALT window.

6. View the Quick Look report.

Select Database menu = Quick Look.

As with the Standard Measures Report, you are presented with a dialogue box to select a measure
of length for the database comparison. Select All: entire transcript and click OK.

Note: Recall, the “Equated: by length” option compares the target speaker’s performance to
database samples matched by some measure of length. The “Measure-driven: combination of All
and Equated” option is not available here, as the Quick Look report does not contain both types of
measures — All and Equated.

The Quick Look display is a chart of relative strengths and weaknesses from several important
variables. You can see at a glance that Carter’s vocabulary diversity is a strength and increased
mazing is a weakness.

7. View the Transcript Length and Intelligibility report.

Select Database menu = Transcript Length & Intelligibility.

You are again presented with a dialogue box to select a measure of length for the database
comparison. Select All: entire transcript and click OK.

Note: The "Measure-driven: combination" option is not available. "All: entire transcript" is pre-
selected. This occurs for narratives, expositories, and persuasion samples because these samples
end when the speaker completes the task. Contrast this with conversations, play, and other samples
which are open-ended. For those samples, "Equated: same number of total words" is pre-selected
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for the fairest comparison.

Look through the report paying attention to the intelligibility values.
o X word —unintelligible word

o XX words — unintelligible segment (more than a word, less than an utterance)
o XXX words — unintelligible utterance

8. View the Verbal Facility Summary report.

e Since 25% of Carter’s words are in mazes, it’s important to look at these mazes in more detail. To do
this, select Database menu = Verbal Facility Summary.

o  When presented with the dialogue box, select Measure-driven: combination of All and Equated
and click OK.

e This report is divided into four sections: rate summary, pause summary, maze summary, and
abandoned utterances.

o Look at the Pause Summary. Carter’s sample contained a significantly high number of within-
utterance pauses at 8 compared to just over 2 in the database comparison set. He paused for
30 seconds compared with 7 seconds in the database. Long and/or frequent pauses may
indicate word finding or utterance formulation difficulties.

o Look at the Maze Summary and notice that Carter produced a significant number of mazes at
both the word and phrase levels.

e For questions about this or any other report, refer to the built-in help screen (|£I or F1).

9. View error codes.

e Carter produced a high number of errors in his language sample. The errors summary is an
important follow-up report. Select Database menu = Errors Summary.

e When presented with the dialogue box, select Measure-driven: combination of All and Equated
and click OK.

e This report lists specific error codes and their frequency within the transcript.

e Suppose you want to see the utterances containing those error codes. To do this, select Analyze
menu - Standard Utterance Lists.

e There are a number of lists to choose from. Notice the default Speaker is the 1 speaker (Child
who, in this case, is Carter) and that the Utterance Base is set to Total utterances. Select
Utterances with... Error Codes, and click List to generate the list of all utterances containing error
codes. Do you notice any patterns?
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C. Change the Database Comparison Set
1. For practice, refine the database comparison set and re-run the Standard Measures Report.
e STEP 1: Select database

- Select Database menu - Change Database Samples and Settings and you are presented with
the “Select Database Samples” dialogue box.

e STEP 2: Select age, grade, and/or gender criteria

- Narrow the Age match from plus or minus 6 months to plus or minus 4 months. Do this by
clicking the down-arrow to the right of the number 6 twice until it reads 4 months.

- Click the Find Matched Samples button again to see how many of the database samples are
with 4 months of Carter’s age. Notice that 60 samples match.

- Check the Grade match and then click Find Matched Samples to see how many of the 60
samples match Carter’s grade, i.e., 2" grade. Notice that 59 samples match. This indicates that 1

of the 60 samples either did not have grade specified or the participant was not in the 2" grade.

- Check the Gender match to restrict the comparison set to males only. Notice the “M” was
automatically filled in to match the gender value of the transcript (+Gender plus line).

- Click Find Matched Samples and notice that 36 of the matching database participants are male.

There is a tradeoff between matching the samples more closely by age, grade, and gender
and the number of samples selected.

e STEP 3: Select method used to equate samples by length

- Select Same number of analysis-set utterances (C&I Verbal Utts) to equate the samples by the
number of utterances.

- Click the Find Equated Samples button to see how to equate Carter’s sample, which contains 40
C&I Verbal Utts (refer to transcript information at the bottom of the dialogue box), with the
matching database samples.

You are presented with a list of choices. Notice that only 14 of the 36 samples contain at least
40 utterances.

- Asarule of thumb, you should have at least 20 participants in the comparison set. The first
option has only 14 participants with the maximum number of utterances. The second option has
20 participants with 36 utterances. If we select the second option, we would have 20
participants in the comparison set but only the first 36 utterances of both Carter’s sample and
the database samples would be used.

Recall that we have restricted the comparison set to 2" grade males. Rather than select any of
these comparison sets, let’s go back and change that.
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Click Cancel to go back to the previous dialogue box.

Leave the Age match at plus or minus 4 months and the Grade match at 2" grade. We have
found that most language measures are not affected by gender so uncheck the Gender match.

Click Find Matched Samples and notice that 59 of the database participants are selected.
Click the Find Equated Samples button and you are presented with a list of choices.

For this exercise, you will maximize the number of utterances by selecting the first option, 28
samples — 40 utterances. Make sure the first option is highlighted and then press OK. You are

returned to the previous dialogue box. The 28 database samples will all be cut at the point of 40
complete and intelligible verbal utterances to match the length of Carter’s sample.

Click OK to exit the dialogue box. The Database menu is displayed and the database reports are

available.

View the Standard Measures Report.

Select Database menu - Standard Measures Report.

When prompted to select what the report is based on, select Measure-driven: combination of
All and Equated and click OK.

After a short delay, the report is displayed. The 59 samples are matched by age (+/- 4 months)
and grade (2M).

D. Change the Standard Deviation Interval

Recall that measures which are at least 1 standard deviation (SD) above or below the database means are
highlighted and followed by one asterisk. Two asterisks are used to flag measures that are at least 2 SDs
from the means. Suppose, for example, that you work for a school district that considers a 1.5 SD interval as
significant. You can change the SD setting so that measures that are at least 1.5 SDs above or below the
mean are followed by one asterisk and measures that are at least 3 SDs from the mean are followed by two

asterisks.

1. Change the SD setting.

Select Database menu = Change Database Samples and Settings.

The standard deviation interval setting is located on the right side of the dialogue box. Change the
SD from 1 to 1.5 and click OK.

2. View the Standard Measures Report with the new comparison set.

Select Database menu - Standard Measures Report.

When prompted to select what the report is based on, select Measure-driven: combination of All
and Equated and click OK.
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Notice that only those measures which are at least 1.5 SD from the database mean are highlighted
and followed by one asterisk. The actual values are not affected.

Note the bottom of the report window displays the SD interval setting.

3. Close All Windows

The screen is getting cluttered so you should close all the windows before continuing with the next
section. You could do this by clicking the X in the upper right-hand corner of each tabbed window.
However, there is a faster way to do this:

Select Window menu = Close All.

E. Open Max’s Transcript

1. Select File menu = Open.

2. Select the transcript file Max EXPO.slt from the “Lesson Samples” folder and then click the Open button
(or double click “Max EXPO.slt”). Max’s transcript is displayed on your screen. Max is 11;2 and is in the
5% grade. He is explaining how to play Monopoly.

Subordination Index (SI). Max’s sample was coded for the subordination index (Sl), a hand-coded
analysis that counts the number of clauses in each utterance. Notice the codes, [SI-0], [SI-1], [SI-2],
etc. inserted at the end of the utterances. Refer to the step-by-step exercise titled “Subordination
Index” for details.

Expository Scoring Scheme (ESS). Scroll down to the end of the transcript and notice the plus lines.
Max’s sample was scored on a scale of 1 to 5 for each these components in an expository. Refer to
the step-by-step exercises titled “Expository Scoring Scheme (ESS)” for details.

F. Compare transcript to the Expository database

1. Select the database comparison set.

Select Database menu - Select Database Samples and Settings.

You are presented with the “Select Database Samples” dialogue box used to select the database
samples to use for the comparison. The default database is Expository. This database was pre-
selected based on the plus line (+ Context: Expo) at the beginning of Max’s sample.

Notice the transcript information at the bottom of the dialogue box:
Max Expo (Child), EXPO: CA = 11;2, Grade 5, Male, 252 NTW, 32 C&I Verbal Utts, Time: 4:02

The transcript filename is “Max Expo”. The target speaker label, taken from the S speaker line at the
beginning of the transcript, is “Child”. He is male, aged 11;2 and is in the 5% grade. This expository
language sample contains 252 NTW (number total words) and 32 C&I (complete and intelligible)
Verbal Utts. The transcript duration is 4 minutes and 2 seconds. The target speaker’s age, grade,
gender, and sampling context came from the plus lines at the beginning of the transcript. These lines
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are automatically inserted when you fill in the header information for new transcripts.
e STEP 2: Select age, grade, and/or gender criteria
- Look at the criteria selections. The Age match is set at plus or minus 6 months.
- Check the Grade match to match 5% graders.

- Click Find Matched Samples to keep the age and grade match criteria and you are informed that
there are 83 matching database samples, all telling how to play some game or sport.

e STEP 3: Select method used to equate samples by length
- Keep the default Same number of total words.

- Click Find Equated Samples to find the number of database samples equated by number of total
words. You are presented with a dialogue box containing six options.

- Select the first option, 78 samples — 252 words.

e SETTINGS: Reset the Standard Deviation Interval to 1SD. It is recommended that the standard
deviation be set to 1SD when you first look at the database reports. This directs your attention to
areas of relative strength and weakness that you might overlook if the SD is set higher.

— Click Reset SD Interval to change the SD from 1.5 to 1.
e Click OK to close the “Select Database Samples” dialogue box.
2. View the Standard Measures Report.

e Select Database menu > Standard Measures Report.

e  When prompted to select what the report is based on, select Measure-driven: combination of All
and Equated and click OK.

e The comparison data is generated from the matching database samples and, after a short delay, you
are presented with the Standard Measures Report.

— TRANSCRIPT LENGTH. Max’s sample is somewhat shorter in utterances, words, and time than his
database peers. A shorter sample does not necessarily indicate a problem. It would be
important to evaluate the quality of Max’s expository to see if he included all the components.

— INTELLIGIBILITY. Max’s sample was 100% intelligible.

- MACRO ANALYSIS. Max’s transcript was coded for Expository Scoring Scheme (ESS). This was
done by inserting the ESS template with scores at the bottom of the transcript and evaluating
his sample on ten expository components, e.g., preparations, scoring, rules. The “ESS Composite
Score”, the total of the ten individual component scores, was significantly lower than his
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database peers. This indicates that components of his expository were either missing or
incomplete.

SYNTAX/MORPHOLOGY. Max’s mean length of utterance (MLU) is significantly low. His sample
included utterances without verbs. Additionally, he used fewer Verbs/Utterance which is a gross
measure of sentence complexity. Recall that the Subordination Index (SI) codes were added to
Max’s sample to measure clausal density. All the expository database samples were also coded
for SI. The “SI Composite Score” reported in this section is the mean number of clauses per
utterance. Both Verbs/Utterance and Sl indicate that Max’s utterances were less complex than
those in the database samples.

SEMANTICS. Max used slightly fewer different words (NDW) in his expository. This measure was
based on 78 database samples equated by the same number of words in Max’s sample. In this
report, the value is italicized as a warning that it’s an outcome that can be affected by different
sample lengths. The moving-average NDW, however, is significantly lower than the database
samples indicating reduced vocabulary diversity. For more information on the moving-average

NDW, refer to the built-in help screen (|ﬁ| or F1). Moving averages mitigate the effects of
sample length.

VERBAL FACILITY. Max’s speaking rate in words per minute was slower than his peers. His
sample contained significant pause time. 32.7% of his words were in mazes (repetitions,
revisions, filled pauses) compared to the database mean of 10.45. He abandoned a substantial
number of utterances.

ERRORS. Max’s sample contained a typical level of errors.

3. View the Performance Report.

e Select Database menu = Performance Report.

You are prompted with the “Performance Report Settings” dialogue box. The speaker’s first name, Makx,

is taken from the “+ Name” entry near the beginning of the transcript. Similarly, the speaker’s gender,

Male, is taken from the “+ Gender” entry in the transcript.

e Press OK and the Performance Report is displayed.

e Read through the report looking for areas of strengths and weaknesses.

Macro Analysis: Max’s sample was coded for Expository Scoring Scheme (ESS), evaluating his
sample on ten expository components, e.g., preparations, scoring, rules. Max’s expository was
deficient in all ten components.

Syntax/Morphology: Max’s mean length of utterance (MLU) was low. His transcript was coded
for Subordination Index (Sl). This was done by inserting [SI-0], [SI-1], [SI-2], ... codes at the end of
all qualifying utterances to measure clausal density. His Sl score was low compared to the
database samples.

Verbal Facility: Max had a slow speaking rate due, at least in part, to frequent and lengthy
pauses. He also produced a high number of mazes.
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Recall that this report may be edited, copied, and pasted into your diagnostic reports, and saved as
an RTF file which can be opened in Microsoft® Word and other word processors.

4. View the Expository Structure report.
e Max's transcript was coded for the Expository Scoring Scheme (ESS). To generate the report
comparing Max’s performance to the database comparison set, select Database menu >

Expository Scoring Scheme.

Notice that, in all ten categories, Max’s expository structure score was significantly lower
than his database peers.

5. View the Subordination Index report from the Syntax/Morphology section.

e Max’s transcript was coded for Subordination Index (SI). To generate the report comparing Max’s
performance to the database comparison set, select Database menu = Subordination Index.

e  When prompted to select what the report is based on, select Equated: same number of total words
and click OK.

Notice that none of Max’s utterances contained more than two clauses.
6. View the Semantics Summary.

e Select Database menu = Semantics Summary.

e  When prompted to select what the report is based on, select Measure-driven: combination of All
and Equated and click OK.

This report lists several word lists. Max used more question words, conjunctions, and personal
pronouns than the database samples but fewer different types of conjunctions and personal
pronouns. This is not surprising given that his number of different words (NDW) was low.

7. View the Verbal Facility Summary.

e Select Database menu = Verbal Facility Summary.

o  When prompted to select what the report is based on, select Measure-driven: combination of All
and Equated and click OK.

Read through the report. In the Help menu click the context help button for further information
about each value.

G. Generate a Database Explore Words & Codes report.

Recall from the Semantics Summary report that Max used fewer different conjunctions than the database
samples. This section looks for the conjunctions Max’s used.
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1. Select Database menu - Explore Words & Codes...

2. When prompted to select what the explore list is based on, select Equated: same number of total
words and click OK.

You are presented with the Database Explore Words and Codes dialogue box. Here you may enter your
own list of vocabulary words for comparison to the database. To get a list of the conjunctions Max used,
you could select the “Standard Words Lists” option in the Analyze menu. However, if you wanted to see
which conjunctions he used compared to those used by the database comparison set, you would enter
the list here.

3. Notice that the settings determine where to look for these conjunctions. Change the utterance base to
“Total utterances”, and keep the search area as “Main body” and the type of analysis (right-hand side of
dialogue box) as “Count number of occurrences”.

4. Type in the list of conjunctions, one per line. They may be entered in either upper or lower case as case
is ignored. Type

AFTER
AND
AS
BECAUSE
BUT

IF

OR
SINCE
SO
THEN
UNTIL
WHILE

e Press OK to view the report. There is a delay while the database samples are scanned for production
of these conjunctions.

When the report is displayed, notice that Max used the conjunctions “AND”, “IF”, “SO”, and “THEN".
The only conjunction he did not produce, that was used significantly more times by his database
peers, is the conjunction “OR”. The database mean indicates that “OR” was found an average of 2.9
times across the 78 language samples selected from the database. The database range of 0 - 8
indicates that this word was not found in at least one of the database samples and it was found 8
times in at least one other sample. Suppose you want to know how many of the 78 database
samples used the word “OR".

« Click the REPEAT icon L] or select Database menu > Explore Words & Codes... again.

e When prompted to select what the explore list is based on, select Equated: same number of total
words and click OK.

e Change the “Type of Analysis” setting (right-hand side of dialogue box) to Presence (X) or Absence
(O) and press OK to view the report.

This report focuses on whether or not the conjunctions were used. It does not report the number of
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times they were used. An “X” indicates that the word was used in Max’s sample and an “O” indicates
that it was not used. The only database statistic displayed is the percent of the transcripts that used
each word. Notice that the conjunction “OR” was used by 90% of the database samples. What is the

only conjunction used in all 78 database samples? Did Max use this conjunction?

H. Close All Windows.

e Select Window menu = Close All.




	Comparing a Transcript to Database Samples
	A. Start SALT with Carter’s Transcript
	B. Compare transcript to samples from the Narrative Story Retell database
	C. Change the Database Comparison Set
	D. Change the Standard Deviation Interval
	E. Open Max’s Transcript
	F. Compare transcript to the Expository database
	G.  Generate a Database Explore Words & Codes report.

